
Act! 1.1 for Windows
The following field maps for Act! 1.1 for Windows are supplied with ZAURUS Data Exchange 
Utility.

Import

Note: each of these field maps are identical except for the target Data File on ZAURUS.

Act11 to Data File 
1

- Imports Act! 1.1 for Windows delimited (.CSV) 
files into Data File 1 on your Zaurus.

Act11 to Data File 
2

- Imports Act! 1.1 for Windows delimited (.CSV) 
files into Data File 2 on your Zaurus.

Act11 to Data File 
3

- Imports Act! 1.1 for Windows delimited (.CSV) 
files into Data File 3 on your Zaurus.

Export

Note: each of these field maps are identical except for the source Data File on ZAURUS.

Data File 1 to 
Act11

- Exports Data File 1 from your Zaurus to a 
delimited (.CSV) file for Act! 1.1 for Windows.

Data File 2 to 
Act11

- Exports Data File 2 from your Zaurus to a 
delimited (.CSV) file for Act! 1.1 for Windows.

Data File 3 to 
Act11

- Exports Data File 3 from your Zaurus to a 
delimited (.CSV) file for Act! 1.1 for Windows.



Act! 1.1 to Data File 1/2/3
The Import field maps for Act! 1.1 for Windows to Data File 1, 2, or 3 on ZAURUS are defined 
as follows:

Act! 1.1 
for 
Windows

Zaurus

Name > Field 1
Contact > Field 2
Addr1 > Field 3
Addr2 > Field 4
Addr3 > Appended to Field 4 with leading carriage 

return.
City > Appended to Field 3 with leading carriage 

return.
State > Appended to Field 3 with leading carriage 

return.
Zip > Appended to Field 3 with leading carriage 

return.
Phone > Field 5
Fax Phone > Field 6
Ext > Field 7
Title > Field 8
Secretary > Field 9
Salutation > Field 10
Results > Field 11
Status > Field 12
Referred > Field 13

Related topics:
Act! 1.1 for Windows



Act! 2.0 for Windows
The following field maps for Act! 2.0 for Windows are supplied with ZAURUS Data Exchange 
Utility.

Import

Note: each of these field maps are identical except for the target Data File on ZAURUS.

Act2 to Data File 1 - Imports Act! 2.0 for Windows delimited (.CSV) 
files into Data File 1 on your Zaurus.

Act2 to Data File 2 - Imports Act! 2.0 for Windows delimited (.CSV) 
files into Data File 2 on your Zaurus.

Act2 to Data File 3 - Imports Act! 2.0 for Windows delimited (.CSV) 
files into Data File 3 on your Zaurus.

Export

Note: each of these field maps are identical except for the source Data File on ZAURUS.

Data File 1 to Act2 - Exports Data File 1 from your Zaurus to a 
delimited (.CSV) file for Act! 2.0 for Windows.

Data File 2 to Act2 - Exports Data File 2 from your Zaurus to a 
delimited (.CSV) file for Act! 2.0 for Windows.

Data File 3 to Act2 - Exports Data File 3 from your Zaurus to a 
delimited (.CSV) file for Act! 2.0 for Windows.



Act! 2.0 to Data File 1/2/3
The Import field maps for Act! 2.0 for Windows to Data File 1, 2, or 3 on ZAURUS are defined 
as follows:

Act! 2.0 
for 
Windows

Zaurus

Name > Field 1
Contact > Field 2
Addr1 > Field 3
Addr2 > Field 4
Addr3 > Appended to Field 4 with leading carriage 

return.
City > Appended to Field 3 with leading carriage 

return.
State > Appended to Field 3 with leading carriage 

return.
Zip > Appended to Field 3 with leading carriage 

return.
Phone > Field 5
Fax Phone > Field 6
Ext > Field 7
Fax Ext > Field 8
Title > Field 9
Assistant > Field 10
Salutation > Field 11
Results > Field 12
Status > Field 13
Referred > Field 14

Related topics:
Act! 2.0 for Windows



Apptmnt to Schedule+
The Export field map for Appointment from ZAURUS to a file (.SDF) for Schedule+ 1.0 is 
defined as follows:

Zaurus Schedule+
Date > Date
StartTime > Start (time)
EndTime > End (time)
AlarmTime > Reminder (min before)
Description > Description
AlarmBit > [not mapped]

Notes: 

1
.

When Exporting, set the Date Format to YYYYMMDD, and the 
New-Line Translation to Horizontal Tab, under Format Options.

2
.

Although the AlarmTime field is mapped to the proper 
Schedule+ field, this data is not shown in Schedule+ because 
of a data format incompatibility in the AlarmBit field.

Related topics:
Schedule+ 1.0



Backup
Backup copies of the data on your ZAURUS to your PC for safe keeping.    You can then 
Restore this data back to your Zaurus any time you wish. It is a good idea to backup your 
ZAURUS periodically in the event it is ever lost, physically damaged, etc.

Step-by-step instructions

Click on parts of the window below for more information about a particular area.



Backup Step-by-Step
Backup copies the data on your ZAURUS to your PC for safe keeping.    You can then Restore 
this data back to your Zaurus any time you wish. It is a good idea to backup your ZAURUS 
periodically in the event it is ever lost, physically damaged, etc.

To perform a backup:

1. On the main screen, select the Backup button (or select Backup from
the File menu, or press Alt-B). The Backup dialog box is shown.

2. Select the File Name box, and enter a filename for the backup file. If 
you would like to overwrite an existing file, select it in the Files list.
In the Drives list, select the drive where you would like the backup 
file saved.
In the Directories list, select the directory where you would like the 
backup file saved.

3. Enter any comments you would like in the Description field. These 
will be stored as part of the backup file. (Optional).

4. If you would like to password protect the backup file, select the Lock 
File check box.

5. Select the data source from the Backup From box, either Main or 
Card memory.

6. When you're finished, select the OK button.

7. If you selected the Lock File option, the Setup Backup Password 
dialog box is displayed.
Enter a password for the backup file (up to 7 characters) in the Enter 
New Password field. Reenter the same password in the Reenter New 
Password field, and select the OK button.

8. The Connect Zaurus dialog box is displayed.
Make sure that your ZAURUS is connected and in PC Link mode , and 
then select the OK button. If your ZAURUS itself is locked, the 
ZAURUS Secret Password dialog is displayed (after a short delay). 
Enter your Zaurus password, and select the OK button.

9. The Backup Progress dialog box is shown and the backup is started.
To stop the backup, select the Cancel button.
If your ZAURUS is not in PC Link mode or there is a problem with the 
communications between your ZAURUS and PC, a Backup Error 
dialog box will be displayed. Check the connections and make sure 
your ZAURUS is in PC Link mode, and then select the Retry button.

Related topics
Backup
Selecting the data source 
Restore 
Connecting ZAURUS to PC 
PC Link Mode 





Backup Description

You may enter a description of the backup for future reference. The description is stored with
the backup file, and is displayed when you select the backup file for a Restore.



Backup File Name

Enter a file name for the PC file that will contain the backup data from your ZAURUS.



Backup From

The Backup From box allows you to select the data source for the backup:

Main memory
Backup from your ZAURUS's internal memory.

Card memory
Backup from a PCMCIA memory card which is in your ZAURUS's card slot.



Connecting ZAURUS and PC
Any of the following can be used to connect your ZAURUS and PC for communications:

o SHARP CE-IR4 Wireless Interface (infrared).

o Aegis PC-Link cable (from the special offer on the ZAURUS 
registration card).

o Any PC-Link cable originally designed for use with a SHARP Wizard 
electronic organizer (e.g. SHARP CE-133T Level Converter, SHARP 
CE-137T Level Converter).

o Any Wireless Interface originally designed for use with a SHARP 
Wizard electronic organizer (e.g. SHARP CE-IR2).

Please call 1-800-BE-SHARP for information on how to order any of the products above.

A standard RS-232C cable is required to use the SHARP CE-IR4 Wireless Interface.
If the RS-232C port of your PC has a 9-pin connector, then a 25-pin to 9-pin adapter is 
required.

SHARP CE-IR4 Wireless Interface

1
.

Turn off your PC and CE-IR4 unit.

2
.

Attach one end of the RS-232C cable to the RS-232C port (COM1-
COM4) of your PC.

3
.

Attach the other end of the RS-232C cable to the port on the CE-IR4.

4
.

Make sure the CE-IR4 has power, either using batteries or the 
optional SHARP EA-11E AC Adaptor.

5
.

To communicate, make sure the infrared port on your ZAURUS faces 
the infrared port (front) of the CE-IR4 Wireless Interface, and that 
they are no more than 20 inches (50 centimeters) apart. Also, be 
sure to turn the CE-IR4's power on before attempting 
communications.



Aegis Cable

1
.

Turn off your PC and ZAURUS.

2
.

Connect the 15-pin end of the Aegis cable to the 15-pin cable jack of 
your ZAURUS (marked COMPUTER LINK on the left edge of the 
keyboard). 

3
.

Attach the 9-pin end of the Aegis cable (or use the 9-to-25-pin 
adapter, if necessary) to the RS-232C port (COM1-COM4) of your PC.



Creating Export Field Mappings
To create export field mappings:

Not
e:

the ability to create export field mappings depends upon the 
currently selected application and export file format.

1
.

With your ZAURUS in PC-Link mode, select the New button in the Field 
Mapping box of the Export dialog box. Select the OK button in the 
Connect ZAURUS dialog box that appears. The New Mapping dialog box is
displayed.

2
.

Enter a name for the new field map in the Mapping Name field (up to 20 
characters).

3
.

Source File fields can be divided into 1-4 fields using the Split Field 
function. The divided fields can then be mapped individually to the 
Destination File.

4
.

If the Destination File requires fewer or more fields than the default 
number, it can be changed in the Number of Export Fields box. Simply 
use the arrows to increment or decrement the current value (you can 
specify between 1 and 32 fields).

5
.

Select each field in the Source File list, and copy it to the desired 
Destination File field. This can be done in two ways:

o After selecting the field in the Source File list, select the field to move
it to in the Destination File list, and then select the Add> button. The 
field from the Source File list is shown in the Destination File list. 

You may copy multiple fields from the Source File list to the same 
field in the Destination File. Simply continue selecting fields in the 
Source File and select the Add> button without changing the 
Destination File field selection (a maximum of 4 Source File fields can
be mapped to the same Destination File field). The currently selected
Separator character will be inserted between fields automatically. 
The Separator can be changed using the Change Separator drop-
down list. The available separators are:

*
*
*
*
*
*

*

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[NO] - No Separation
[/] - Slash
[+] - Start Time+Duration
Add the Start Time to the Duration to get the End Time.
Note: The Duration is shown in minutes.
[-] - End Time-Start Time
Subtract the End Time from the Start Time to get the Duration.

o Select the Map All> button to copy all of the Source File fields to the 
Destination File automatically. Each Source File field is copied to the 
corresponding Destination File field.



6
.

If necessary, you can remove fields from the Destination File list. To 
remove a field, do the following:

o

o

Select the desired field in the Destination File list, and then select the
Remove button.
Or
Select the Clear All button to remove all fields from the Destination 
File list.

7
.

When you're finished, select the OK button.



Creating Import Field Mappings
To create import field mappings:

Not
e:

the ability to create import field mappings depends upon entering a 
filename, the currently selected application, and the import file 
format.

1
.

With your ZAURUS in PC-Link mode, select the New button in the Field 
Mapping box of the Import dialog box. Select the OK button in the 
Connect ZAURUS dialog box that appears. The New Mapping dialog box is
displayed.

2
.

Enter a name for the new field map in the Mapping Name field (up to 20 
characters).

3
.

Source File fields can be divided into 1-4 fields using the Split Field 
function. The divided fields can then be mapped individually to the 
Destination File.

4
.

The first record of the data to be imported is shown next to each field in 
the Source File field list. To view other records:

o
o

Select the Prev button to display the previous record.
Select the Next button to display the next record.

5
.

Select each field in the Source File list, and copy it to the desired 
Destination File field. This can be done in two ways:

o After selecting the field in the Source File list, select the field to move
it to in the Destination File list, and then select the Add> button. The 
field from the Source File list is shown in the Destination File list. 

You may copy multiple fields from the Source File list to the same 
field in the Destination File. Simply continue selecting fields in the 
Source File and select the Add> button without changing the 
Destination File field selection (a maximum of 4 Source File fields can
be mapped to the same Destination File field). The currently selected
Separator character will be inserted between fields automatically. 
The Separator can be changed using the Change Separator drop-
down list. The available separators are:

*
*
*
*
*
*

*

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[NO] - No Separation
[/] - Slash
[+] - Start Time+Duration
Add the Start Time to the Duration to get the End Time.
Note: The Duration is shown in minutes.
[-] - End Time-Start Time
Subtract the End Time from the Start Time to get the Duration.

o Select the Map All> button to copy all of the Source File fields to the 
Destination File automatically. Each Source File field is copied to the 



corresponding Destination File field.

6
.

If necessary, you can remove fields from the Destination File list. To 
remove a field, do the following:

o

o

Select the desired field in the Destination File list, and then select the
Remove button.
Or
Select the Clear All button to remove all fields from the Destination 
File list.

7
.

When you're finished, select the OK button.



Data File 1/2/3 to Act! 1.1
The Export field maps for Data File 1, 2, or 3 from ZAURUS to a delimited file for Act! 1.1 for 
Windows are defined as follows:

Note: when Exporting, set the New-Line Translation to Space under Format Options.

Zaurus Act! 1.1 for Windows
Field 1 > Name
Field 2 > Contact
Field 3 > Addr1
Field 4 > Addr2
Split 
from 
Field 4.

> Addr3

Split 
from 
Field 3.

> City

Split 
from 
Field 3.

> State

Split 
from 
Field 3.

> Zip

Field 5 > Phone
Field 6 > Fax Phone
Field 7 > Ext
Field 8 > Title
Field 9 > Secretary
Field 10 > Salutation
Field 11 > Results
Field 12 > Status
Field 13 > Referred

Related topics:
Act! 1.1 for Windows



Data File 1/2/3 to Act! 2.0
The Export field maps for Data File 1, 2, or 3 from ZAURUS to a delimited file for Act! 2.0 for 
Windows are defined as follows:

Note: when Exporting, set the New-Line Translation to Space under Format Options.

Zaurus Act! 2.0 for Windows
Field 1 > Name
Field 2 > Contact
Field 3 > Addr1
Field 4 > Addr2
Split 
from 
Field 4.

> Addr3

Split 
from 
Field 3.

> City

Split 
from 
Field 3.

> State

Split 
from 
Field 3.

> Zip

Field 5 > Phone
Field 6 > Fax Phone
Field 7 > Ext
Field 8 > Fax Ext
Field 9 > Title
Field 10 > Assistant
Field 11 > Salutation
Field 12 > Results
Field 13 > Status
Field 14 > Referred

Related topics:
Act! 2.0 for Windows



Deleting Export Field Mappings
To delete an export field mapping:

Not
e:

the ability to delete export field mappings depends upon the 
currently selected application and export file format.

1
.

In the Export dialog box, select the field map to be deleted from the 
Currently Selected Map list.

2
.

Select the Delete button.



Deleting Import Field Mappings
To delete an import field mapping:

Not
e:

the ability to delete import field mappings depends upon entering a 
filename, the currently selected application, and the import file 
format.

1
.

In the Import dialog box, select the field map to be deleted from the 
Currently Selected Map list.

2
.

Select the Delete button.



Directories List

You may change the current directory by selecting it in the Directories list. This list is shown 
as a hierarchical structure of connected folders which represent the directories on the 
currently selected drive.



Drives List

You may change the current drive by selecting it in the Drives drop-down list. The Directories
and Files lists reflect the contents of the selected drive.



Exit ZAURUS Data Exchange Utility
To exit ZAURUS Data Exchange Utility:

o Select Exit from the File menu.
Or,

o Select Close in the control menu box.
Or,

o Press Alt-F4 keys.



Export
Export allows you to transfer data from your ZAURUS to your PC, storing the data in any of 
several standard PC file formats (e.g. .CSV, .SDF, .RTF, .TXT, etc.), depending upon the 
application.

Step-by-step instructions

Click on the area of the window you would like more information about:

Related topics
Pre-configured field maps



Export - Step-by-Step
Export allows you to transfer data from your ZAURUS to your PC, storing it in any of several 
standard PC file formats (e.g. .CSV, .SDF, .RTF, .TXT, etc.).

To export data:

1
.

From the main window, select the Export button, or select Export 
from the File menu. The Export dialog box is displayed.

2
.

Select the application which you wish to export from in the From 
Application drop-down list.

3
.

Select the desired export file format in the Export File Format drop-
down list.

4
.

Select a field mapping in the Currently Selected Map drop-down list. 
There are several pre-configured field maps. Field mappings only 
apply for .CSV and .SDF file formats. If necessary, you can also:

o
o
o

Create new field mappings,
Modify existing field mappings, or
Delete existing field mappings.

5
.

Select the Format Options button to specify the date format and 
new-line translation. Format Options only apply when exporting 
to .CSV and .SDF file formats.

6
.

Select the First Record Contains Field Titles check box if desired. This 
feature is only available for certain applications, and only applies 
when exporting to .CSV or .SDF file formats.

7
.

Select the source of ZAURUS application data to export from in the 
Export From box. 

8
.

When you're finished, select the Export button.

9
.

The Connect Zaurus dialog box is displayed.
Make sure that your ZAURUS is connected and in PC Link mode, and 
select the OK button.

1
0
.

The next steps are determined by the application from which you are
exporting.
If you are exporting Documents, Outlines, Notes, Scrapbook, or PC 
Files, each entry in the application is exported individually.

o
o

A list of application entries is displayed.
Select the entry to be exported from the list, and select the OK 
button.

For all other applications, all entries in the application are exported 
to one file. 

1
1

The Export File Name dialog box is displayed.
Enter a filename for the export file in the File Name box. If you would



. like to overwrite an existing file, select it in the Files list.
In the Drives list, select the drive where you would like the export file
saved.
In the Directories list, select the directory where you would like the 
export file saved.

1
2
.

When you're finished, select the OK button. The export process will 
begin, and a progress dialog will be displayed.

Related topics
Selecting the application to be exported. 
Selecting the export file format. 
Pre-configured field maps
Creating a field map for the application to be exported. 
Modifying a field map for the application to be exported. 
Deleting a field map. 
Selecting the export data source. 
Specifying format options. 



Export From

The Export From box allows you to select the data source for the export:

Main memory
Export from your ZAURUS's internal memory.

Card memory
Export from a PCMCIA memory card which is in your ZAURUS's card slot.



Export file formats
The following export file formats can be selected in the Export File Format box of the Export 
dialog box. The availability of a specific file format depends on the selected application.

ZAURUS Data Format (.ZDF)
A special ZAURUS file format. This is best used when the data will be imported back into a 
ZAURUS.

Comma Separated Values (.CSV)
A file format which encloses each field with double quotes ("), divides each field in the 
record with a comma (,), and ends each record with a carriage return/line feed.

Standard Delimited Format (.SDF)
A file format similar to .CSV, but which is supported and defined by Borland's dBase 
database.

Plain Text Format (.TXT)
Plain ASCII text format. Nearly any word processor or editor can read and write this format.

Rich Text Format (.RTF)
A file format defined by Microsoft that maintains the formatting and general appearance of a
document (bold facing, underlining, etc.).

Windows Bitmap Format (.BMP)
A common graphic file format supported by most graphics programs, including Windows 
Paintbrush.

No Conversion
Data will be transferred to your PC without any format conversion.



Field Mapping

The Field Mapping capability of ZAURUS Data Exchange Utility allows you to tailor the import
and export field layouts when either the .CSV or .SDF file formats have been selected. This 
provides the ability to match the data format requirements of other applications with which 
you may want to exchange data. You may reorder, combine, split, or ignore fields as 
necessary.



File Menu
The File menu provides access to the main functions of ZAURUS Data Exchange Utility:

Backup 
Restore 
Export 
Import 
Exiting the application 



Files List

The Files list shows the files on the currently selected drive, in the currently selected 
directory, and subject to the currently selected file mask in the List Files of Type drop-down 
list.



First Record Contains Field Titles (Export)

If you wish to include the field titles of the application you are exporting as the first record in
the export file, select the First Record Contains Field Titles check box. This feature is only 
available for certain applications, and only applies when exporting to .CSV or .SDF file 
formats.



First Record Contains Field Titles (Import)

If the first record of the file you are importing contains field titles, and you do not want them 
imported as an application entry, select the First Record Contains Field Titles check box. The 
first record of the import file will be ignored during the import process. This feature is only 
available for certain applications, and only applies when importing from .CSV or .SDF file 
formats.



Format options
When exporting ZAURUS application data to either .CSV or .SDF file formats, you can specify
two Format Options; the Date Format, and the New-Line Translation.

To specify Format Options:

1
.

Select the Format Options button in the Export dialog box. The 
Format Options dialog box is displayed.

2
.

In the Date Format box, select the desired date format. When an 
exported application's data contains a date field and you are 
exporting to a file format of CSV or SDF, the date field is converted to
the selected format. This allows you to match the date field 
requirements for another application which will read the exported 
file.
The following date formats may be selected:

Format
MM/DD/YY
DD.MM.YYYY
YYYYMMDD

Example
12/25/95
25.12.1995
19951225

3
.

In the New-Line Translation box, select the character that you want 
ZAURUS new-line characters converted to. This allows you to match 
the new-line (end-of-line) requirements for another application which 
will read the exported file.
The following new-line characters may be selected:

Vertical Tab (VT)
Horizontal Tab (HT)
Carriage Return (CR)
Line Feed (LF)
Space

4
.

When you are finished, select the OK button.

Related topics
Export 
Selecting the application to be exported. 
Selecting the export file format. 



Help menu
The Help menu provides access to the following help information:

Contents The Table of Contents of this online help.
Search for Help 
on

Start a search for specific topics in this online help.

How to Use Help Help on how to use the Windows Help program that is 
used to display this online help.

About Version and copyright information about ZAURUS Data 
Exchange Utility.



Import
Import allows you to transfer data from standard PC file formats (e.g. .CSV, .SDF, .RTF, .TXT, 
etc.) to the applications in your ZAURUS.

Step-by-step instructions

Click on the area of the window you would like more information about:

Related topics
Pre-configured field maps



Import - Step-by-Step
Import allows you to transfer data from standard PC file formats (e.g. .CSV, .SDF, .RTF, .TXT, 
etc.) to the applications in your ZAURUS.

To import data:

1
.

From the main window, select the Import button, or select Import 
from the File menu. The Import dialog box is displayed.

2
.

Select the application which you wish to import to in the Into 
Application drop-down list.

3
.

Select the import file format in the Import File Format drop-down list.

4
.

Enter the import file name in the File Name field, or select the 
Browse button, and select the import file name.

5
.

Select a field mapping in the Currently Selected Map drop-down list. 
There are several pre-configured field maps. Field mappings only 
apply for .CSV and .SDF file formats. If necessary, you can also:

o
o
o

Create new field mappings,
Modify existing field mappings, or
Delete existing field mappings.

6
.

Select the First Record Contains Field Titles check box if desired. This 
feature is only available for certain applications, and only applies 
when importing from .CSV or .SDF file formats.

7
.

Select the import data destination in the Import To box. 

8
.

Select the Preview button to view the contents of the import file. The
Import Preview dialog box is displayed. Select the Close button to 
return to the Import dialog box. 

9
.

When you're finished, select the Import button.

1
0
.

The Connect Zaurus dialog box is displayed.
Make sure that your ZAURUS is connected and in PC Link mode, and 
select the OK button.

1
1
.

The import process will begin, and a progress dialog box will be 
displayed.

Related topics
Select the application to be imported to. 
Select the import file name. 
Select the import file format. 
Pre-configured field maps
Create a field map for the import file. 
Modify a field map for the import file. 
Delete a field map. 
Select the data destination to be imported to. 





Import File Name

Enter the file name of the file you wish to import from your PC into your ZAURUS. You may 
also use the Browse button to find the desired file.



Import Preview

Select the Preview button to view the contents of the PC file you have selected to import. 
This can be helpful when you are not sure about the contents or format of the selected file. 
Only a text view of the data is provided, so Preview is useful mainly for viewing .CSV, .SDF, 
and .TXT files that you are about to import.



Import To

The Import To box allows you to select the data destination for the import:

Main memory
Import to your ZAURUS's internal memory.

Card memory
Import to a PCMCIA memory card which is in your ZAURUS's card slot.



Import file formats
The following import file formats can be selected in the Import File Format box of the Import 
dialog box. Note that the availability of a specific file format depends on the selected 
application.

ZAURUS Data Format (.ZDF)
A special ZAURUS file format produced by ZAURUS Data Exchange Utility.

Comma Separated Values (.CSV)
A file format which encloses each field with double quotes ("), divides each field in the 
record with a comma (,), and ends each record with a carriage return/line feed.

Standard Delimited Format (.SDF)
A file format similar to .CSV, but which is supported and defined by Borland's dBase 
database.

Plain Text Format (.TXT)
Plain ASCII text format. Nearly any word processor or editor can read and write this format.

Rich Text Format (.RTF)
A file format defined by Microsoft that maintains the formatting and general appearance of a
document (bold facing, underlining, etc.).

Windows Bitmap Format (.BMP)
A common graphic file format supported by most graphics programs, including Windows 
Paintbrush.

No Conversion
Data will be transferred to your ZAURUS without any format conversion.



List Files of Type

The Files list only shows files matching the file mask selected in the List Files of Type drop-
down list. Selecting a different file mask in the List Files of Type list will change the files 
shown in the Files list.



Lock File

Selecting the Lock File check box password-protects the backup file (you are prompted for 
the password when you click OK in the Backup dialog box). When the backup file is locked, it 
can not be Restored without supplying the password at the time of the Restore. It is useful to
lock the backup file when you don't want others to be able to restore your data to their 
Zaurus.



Modifying Export Field Mappings
Existing export field mappings can be modified as necessary.

To modify export field mappings:

Not
e:

the ability to modify specific export field mappings depends upon the
currently selected application and export file format.

1
.

Select the field map which you wish to modify from the Currently Selected
Map drop-down list in the Field Mapping box of the Export dialog box.

2
.

With your ZAURUS in PC-Link mode, select the Modify button in the Field 
Mapping box. Select the OK button in the Connect ZAURUS dialog box 
that appears. The Modify Mapping dialog box is displayed.

3
.

Source File fields can be divided into 1-4 fields using the Split Field 
function. The divided fields can then be mapped individually to the 
Destination File. You must clear all field mappings before you can split a 
field.

4
.

If the Destination File requires fewer or more fields than the default 
number, it can be changed in the Number of Export Fields box. Simply 
use the arrows to increment or decrement the current value (you can 
specify between 1 and 32 fields).

5
.

Select each field in the Source File list, and copy it to the desired 
Destination File field. This can be done in two ways:

o After selecting the field in the Source File list, select the field to move
it to in the Destination File list, and then select the Add> button. The 
field from the Source File list is shown in the Destination File list. 

You may copy multiple fields from the Source File list to the same 
field in the Destination File. Simply continue selecting fields in the 
Source File and select the Add> button without changing the 
Destination File field selection (a maximum of 4 Source File fields can
be mapped to the same Destination File field). The currently selected
Separator character will be inserted between fields automatically. 
The Separator can be changed using the Change Separator drop-
down list. The available separators are:

*
*
*
*
*
*

*

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[NO] - No Separation
[/] - Slash
[+] - Start Time+Duration
Add the Start Time to the Duration to get the End Time.
Note: The Duration is shown in minutes.
[-] - End Time-Start Time
Subtract the End Time from the Start Time to get the Duration.

o Select the Map All> button to copy all of the Source File fields to the 
Destination File automatically. Each Source File field is copied to the 



corresponding Destination File field.

6
.

If necessary, you can remove fields from the Destination File list. To 
remove a field, do the following:

o

o

Select the desired field in the Destination File list, and then select the
Remove button.
Or
Select the Clear All button to remove all fields from the Destination 
File list.

7
.

When you're finished, select the OK button.



Modifying Import Field Mappings
Existing import field mappings can be modified as necessary.

To modify import field mappings:

Not
e:

the ability to modify specific import field mappings depends upon 
entering an import filename, the currently selected application, and 
the import file format.

1
.

Select the field map which you wish to modify from the Currently Selected
Map drop-down list in the Field Mapping box of the Import dialog box.

2
.

With your ZAURUS in PC-Link mode, select the Modify button in the Field 
Mapping box. Select the OK button in the Connect ZAURUS dialog box 
that appears. The Modify Mapping dialog box is displayed.

3
.

Source File fields can be divided into 1-4 fields using the Split Field 
function. The divided fields can then be mapped individually to the 
Destination File. You must clear all field mappings before you can split a 
field.

4
.

The first record of the data to be imported is shown next to each field in 
the Source File field list. To view other records:

o
o

Select the Prev button to display the previous record.
Select the Next button to display the next record.

5
.

Select each field in the Source File list, and copy it to the desired 
Destination File field. This can be done in two ways:

o After selecting the field in the Source File list, select the field to move
it to in the Destination File list, and then select the Add> button. The 
field from the Source File list is shown in the Destination File list. 

You may copy multiple fields from the Source File list to the same 
field in the Destination File. Simply continue selecting fields in the 
Source File and select the Add> button without changing the 
Destination File field selection (a maximum of 4 Source File fields can
be mapped to the same Destination File field). The currently selected
Separator character will be inserted between fields automatically. 
The Separator can be changed using the Change Separator drop-
down list. The available separators are:

*
*
*
*
*
*

*

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[NO] - No Separation
[/] - Slash
[+] - Start Time+Duration
Add the Start Time to the Duration to get the End Time.
Note: The Duration is shown in minutes.
[-] - End Time-Start Time
Subtract the End Time from the Start Time to get the Duration.



o Select the Map All> button to copy all of the Source File fields to the 
Destination File automatically. Each Source File field is copied to the 
corresponding Destination File field.

6
.

If necessary, you can remove fields from the Destination File list. To 
remove a field, do the following:

o

o

Select the desired field in the Destination File list, and then select the
Remove button.
Or
Select the Clear All button to remove all fields from the Destination 
File list.

7
.

When you're finished, select the OK button.



Option Menu
The Option menu provides access to two communications settings.

Preference Toggle an option to automatically exit PC-Link mode on
your ZAURUS after a data exchange.

Serial Port Set the COM port you are using on your PC to 
exchange data with your ZAURUS.



PC Link mode
PC-Link mode is used to communicate between your ZAURUS and PC.

To put your ZAURUS in PC-Link mode:

1
.

Touch the TOOLS accessory on the left side of the screen.

2
.

Touch the PC LINK utility icon in the TOOLS display.

3
.

Select the PC Link Path by touching either Wireless or Cable.

4
.

Touch OK to enter PC Link mode.

5
.

PC Link mode is set. Press the QUIT (ON) button to exit PC-LINK 
mode.
For more information, see your ZAURUS operation manual.

Related topics
Connecting ZAURUS and PC



Pre-configured field maps
ZAURUS Data Exchange Utility is provided with a few pre-configured field maps. 

In addition to some Default field maps (direct 1-to-1 field maps), field maps are provided for 
a couple of popular third-party applications. These field maps are designed to map the 
default fields of the selected application to the default field configuration of the selected 
ZAURUS application. If you modify the field layout of either the PC application or ZAURUS 
application, you may need to modify the supplied field map.

Field maps are provided for:

Act! 1.1 for Windows
Act! 2.0 for Windows
Schedule+ 1.0



Preference
The Preference dialog allows you to enable the option to automatically exit PC-Link mode (on
your ZAURUS) after data transfers. To access this option, select Preference from the Option 
menu.

Note that if you do not enable this option, your ZAURUS will continuously consume more 
battery power than usual. Also, the Sleep function is disabled when in PC-Link mode. 
Therefore, you should manually disable PC-Link mode as soon as you are done transferring 
data (using the QUIT/ON key).



Product Support
For technical support on ZAURUS Data Exchange Utility, please call:

800-BE-SHARP



Restore
Restore copies of previously backed up data from your PC to your ZAURUS.

WARNING: Restore permanently deletes all existing data from the data destination (main or 
card memory) you select on your ZAURUS!

Step-by-step instructions

Click on parts of the window below for more information about a particular area.



Restore - Step-by-Step
Restore copies previously backed up data from your PC to your ZAURUS.

WARNING: Restore permanently deletes all existing data from the data destination (main or 
card memory) you select on your ZAURUS!

To perform a restore:

1. On the main screen, select the Restore button (or select Restore from
the File menu, or press Alt-R). The Restore dialog box is shown.

2. Enter the name of a previously-created backup file in the File Name 
box, or select it in the Files list.
Select the drive where the backup file can be found from the Drives 
list.
Select the directory where the backup file can be found from the 
Directories list.

3. Select the restore data destination in the Restore To box, either Main 
or Card memory.

4. When you're finished, select the OK button.

5. If the backup file is locked, the Unlock Backup file dialog box is 
displayed. Enter the appropriate password and select the OK button. 
If the password you enter is wrong, the Unlock Backup File dialog box
is displayed again. Either reenter the correct password and select the
OK button, or select the Cancel button to return to the Restore dialog
box.

6. The Connect Zaurus dialog box is displayed.
Make sure that your ZAURUS is connected and in PC Link mode , and 
then select the OK button. If your ZAURUS itself is locked, the 
ZAURUS Secret Password dialog is displayed (after a short delay). 
Enter your Zaurus password, and select the OK button.

7. The Restore Progress dialog box is shown and the restore is started.
To stop the restore, select the Cancel button. 

However, note that canceling the restore operation will leave
your Zaurus in an unusable state. It is highly recommended 
that you do not cancel a restore.

If your ZAURUS is not in PC Link mode or there is a problem with the 
communications between your ZAURUS and PC, a Restore Error 
dialog box will be displayed. Check the connections and make sure 
your ZAURUS is in PC Link mode, and then select the Retry button.

Related topics
Selecting the memory to be restored to. 
Backup 
Connect ZAURUS and PC 
PC Link mode 





Restore File Name

Enter the filename for the previously-created backup file that you wish to restore to your 
ZAURUS. Alternatively, select the file from the Files list. If necessary, select a different drive 
from the Drives drop-down list, a different directory from the Directories list, and/or a 
different file mask from the List Files of Type drop-down list.



Restore To

The Restore To box allows you to select the data destination for the restore:

Main memory
Restore to your ZAURUS's internal memory.

Card memory
Restore to a PCMCIA memory card which is in your ZAURUS's card slot.



Schedule+ 1.0
The following field maps for Schedule+ 1.0 are supplied with ZAURUS Data Exchange Utility. 
In order to use these field maps, you must have the complete version of Schedule+ 1.0 
which includes support for import/export with Sharp Wizard products. The version of 
Schedule+ 1.0 which is currently bundled with Microsoft Windows for Workgroups does not 
include this support.

Import

Schedule+ to 
Apptmnt

- Imports previously-exported Schedule+ 1.0 
Wizard files (.OZW) into Appointments on your
Zaurus.

Export

Apptmnt to 
Schedule+

- Exports Appointments from your Zaurus to a 
file (.SDF) for importing into Schedule+ 1.0.



Schedule+ to Apptmnt
The Import field map for Schedule+ 1.0 to Appointment on ZAURUS is defined as follows:

Schedule+ Zaurus
Date > Date
Start 
(time)

> StartTime

End (time) > EndTime
Reminder 
(min 
before)

> AlarmTime

Descriptio
n

> Description

Reminder 
Set

> AlarmBit

Related topics:
Schedule+ 1.0



Selecting an Import File
To select an import file:

1
.

Selecting the Browse button in the Import dialog box displays the 
Import File Name dialog box.

2
.

Select the drive where the Import file is located from the Drives drop-
down list.

3
.

Select the directory where the Import file is located from the 
Directories list.

4
.

Select the file extension for the Import file from the List Files of Type 
drop-down list.

5
.

Select the desired Import file from the Files list. The file name will be 
displayed in the File Name box.

6
.

Select the OK button.

Related topics
Import 



Selecting the application to be exported
The following ZAURUS applications can be selected for exporting in the From Application Box
of the Export dialog box:

Application Supported Export File Formats
Appointments Comma separated values (.CSV), Standard delimited 

format (.SDF), ZAURUS data format (.ZDF)

To Do Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Birthday/
Anniversary

Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Holiday by Date Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Holiday by Day Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact1 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact2 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact3 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 1 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 2 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 3 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Notes Windows bitmap (.BMP), ZAURUS data format (.ZDF)

Documents Text (.TXT), Rich text format (.RTF), ZAURUS data 
format (.ZDF)

Outlines Text (.TXT), ZAURUS data format (.ZDF)

Scrapbook Windows bitmap (.BMP), ZAURUS data format (.ZDF)

PC Files No conversion

Note: For Documents, Outlines, Notes, Scrapbook and PC Files, each application data entry is
exported to a separate file.    For all other applications, all application data entries are 



exported to one file.



Selecting the application to be imported to
The following ZAURUS applications can be selected for importing to in the Into Application 
box of the Import dialog box:

Application Supported Import File Formats
Appointments Comma separated values (.CSV), Standard delimited 

format (.SDF), ZAURUS data format (.ZDF)

To Do Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Birthday/
Anniversary

Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Holiday by Date Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Holiday by Day Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact1 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact2 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Contact3 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 1 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 2 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Data File 3 Comma separated values (.CSV), Standard delimited 
format (.SDF), ZAURUS data format (.ZDF)

Notes ZAURUS data format (.ZDF)

Documents Text (.TXT), Rich text format (.RTF), ZAURUS data 
format (.ZDF)

Outlines Text (.TXT), ZAURUS data format (.ZDF)

Scrapbook Windows bitmap (.BMP), ZAURUS data format (.ZDF)

PC Files No conversion

Notes:
o For Documents, Outlines, Notes, Scrapbook and PC Files, each file is 



imported as one application data entry.



Serial Port
Communication between your ZAURUS and PC requires the use of a serial port (i.e. COM 
Port) on your PC for either a direct cable connection to your ZAURUS, or a connection via an 
IR wireless interface unit (such as SHARP CE-IR2 or CE-IR4).

To set the serial port:

1
.

Select Serial Port from the Option menu. The Serial Port dialog box is 
displayed.

2
.

If you know what COM port your ZAURUS is connected to, simply 
select the appropriate port.

3
.

If you do not know which port your ZAURUS is connected to, make 
sure your ZAURUS is connected and in PC-Link mode, and then select
the Find ZAURUS button. Each COM port will be automatically 
checked for the presence of your ZAURUS.

4
.

When the correct port has been selected or found, select the OK 
button to save the setting.



Splitting Fields
When creating a new field mapping for importing or exporting of data between your ZAURUS
and PC, there are instances where it is desirable to split the data of a Source File field into 
two or more (up to 4) parts so they may be mapped individually to Destination File fields.

For example, a person's first name and last name may be in the same field in the Source 
File, but you may want to put them into separate fields in the Destination File.

To split a field:

1
.

Select the Split Field button. The Split Field dialog box is displayed.

2
.

Enter the number of parts (1 to 4) you want in the Split Field into 
box.

3
.

Select the appropriate Separating Character box. The separating 
character determines where the field data will be split during an 
Import or Export.
You can select among:

o
o
o
o

[,] - Comma
[SP] - Space
[CR] - Carriage Return
[/] - Slash

4
.

Select the OK button.



ZAURUS Data Exchange Utility Help Contents
ZAURUS Data Exchange Utility can:

o Backup the data stored on your ZAURUS to your PC.
o Restore backed-up data from your PC to your ZAURUS.
o Export data stored on your ZAURUS to standard PC file formats (CSV, 

SDF, etc.).
o Import data from standard PC file formats to your Zaurus.

Click on parts of the window below for more information about a particular area.

Related topics
Export
Import
Backup
Restore
File Menu
Option Menu
Connecting ZAURUS and PC 
Exiting the application

For Help on Help, Press F1






